CH A P T E R

10

Configuring Personnel and Badges
This chapter describes how to create the personnel records and badges used to access doors in the Cisco
Physical Access Control system.

Note

For instructions to synchronize Cisco PAM with personnel records from another database, see
Chapter 14, “System Integration”.
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Configuring Personnel
Use the Personnel module to manage personnel records. Personnel records contain information on the
site's personnel, such as employees, contractors, and visitors. A personnel record may have associated
credentials, such as badges or logins.

Tip

Personnel records are unique based on the ID number of the record. If a record is imported with the same
ID number, then the current record is updated with the new data.
This section describes how to manage personnel, including adding an image, a badge, and an associated
access level.

Step 1

Open the Personnel module from the Users menu, as shown in Figure 10-2.

Step 2

To add a personnel record, choose Add (Advanced)....
•

To modify an existing record, select the entry and click Edit.

•

To edit all records displayed in the list, click Group Edit.... See Using Group Edit, page 5-14 for
more information.

•

To disable a record, select the entry and choose Disable. This is equivalent to setting the Status to
Inactive.

Figure 10-1

Step 3

Personnel Module: Main Window

Enter the information in the General tab, as shown in Figure 10-2. See Table 10-1 for field descriptions.
The first name, last name, and SSN/FIN/ID fields are required.
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Figure 10-2

Table 10-1

General

Personnel Module: General Tab

Field

Description

Title

(Optional) The person’s formal title. Select a value from the drop-down menu (such
as Dr., Mr., or Ms.) or enter the text manually.

First name

(Required) The person's given name.

Middle name

(Optional) The person's middle name.

Last name

(Required) The person's surname (family name).

Suffix

(Optional) The suffix at the end of the person's name. Select a value from the
drop-down menu (such as I, II, III, Jr., and Sr.) or enter the text manually.

Date of birth

(Optional) The person's birth date.

SSN/ID#/FIN

(Required) Select the type of ID number used from the drop-down menu, and enter
the actual number in the field to the right.
Note

Step 4

Personnel records are unique based on the ID number of the record. If a
record is imported with the same ID number, then the current record is
updated with the new data.

Comments

(Optional) Any additional comments or notes about the personnel record.

Site

(Optional) The site associated with the personnel record.

Import...

(Optional) Click Import... to add an image to the record (select a JPEG image from
a local drive and click OK).

(Optional) Add an image to the personnel record:
a.

Click the Capture... button to open an image capture device interface.
– If a picture has already been taken, click the Import... button and browse to the desired JPEG

image for the person's picture and click the OK button and skip to step 8.
– If the Capture... button is grayed out, enable the capture device in the properties section (see

Enabling Image Capture Devices, page 10-36).
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b.

Use the built in tools to pan, tilt and zoom to the appropriate location. Once satisfied with the camera
settings click the Capture button to take a picture. After clicking the Capture button a preview of
the picture will be displayed.

c.

Click the Save button to save the picture or the Capture button to take another picture. Once the
Save button is selected the Capture Image wizard will open. Using the mouse move the highlighted
box to the appropriate location. The area within the highlighted box will be saved within the
personnel record.

d.

Click Next to preview the finalized image. Click the Finish button to close the wizard and preview
the image within the new personnel record.

Step 5

(Optional) Add a signature to the personnel record. See Enabling Signature Capture Devices for more
information.

Step 6

Enter the Occupational Information for the personnel record, as shown in Figure 10-3. See Table 10-2
for field descriptions.
Figure 10-3

Table 10-2

Occupational Information

Personnel Module: Occupational Information Fields

Field

Description

Title in organization

The person’s title within the organization. For example, Director of
Engineering.

Employee number

The employee number, if applicable. Generally, but not required to be, unique.

Personnel Type

The type of employee. Options include the following:
•

Contractor

•

Employee - Full Time

•

Employee - Part Time

•

Other

•

Visitor
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Table 10-2

Step 7

Personnel Module: Occupational Information Fields (continued)

Field

Description

Status

The status of the employee. Options include the following:
•

Active

•

Inactive

•

On Leave

•

Retired

•

Terminated

Organization

The organization name to which the person belongs. Select a pre-defined
value from the drop-down menu, or type a name in the field. To edit the
pre-defined options, see Editing Organization and Department Lists,
page 10-11.

Department

The department name within the organization to which the person belongs.
Select a pre-defined department name from the drop-down menu, or enter a
name in the field. To edit the pre-defined options, see Editing Organization
and Department Lists, page 10-11.

Date of hire

The date the employee was hired.

Enter the Contact Information for the personnel record, as shown in Figure 10-4. See Table 10-3 for
field descriptions.
Figure 10-4

Contact Information
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Table 10-3

Personnel Module: Contact Information Fields

Field

Description

Address

The physical and/or mailing address(es) of the person. Each record can
contain up to three different addresses:

Phone numbers

Email address

Step 8

•

Work

•

Home

•

Other

The telephone number(s) for the person. Each record can contain up to
five different phone numbers:
•

Work

•

Home

•

Mobile

•

Fax

•

Other

The email address(es) for the person. Each record can contain up to three
different email addresses:
•

Primary

•

Secondary

•

Other

Add a badge to the personnel record.
a.

Click the Badges tab

b.

Click the Add... button to open the badge template window.

c.

Select a template from the menu and click OK. To configure a
badge without using a template, select None.
See Configuring Badge Templates, page 10-18 to create or
modify the templates.

d.

Enter the Card # and PIN (required) in the badge properties window, as shown in Figure 10-5.

e.

Modify the other badge fields, if necessary, as described in Badge Properties, page 10-20.

f.

Click Save and Close to save the badge settings.

g.

(Optional) Activate the changes. Changes to credentials (badges) are downloaded to the Gateways
on a regular schedule. To activate the changes before the next scheduled download, do one of the
following.
– To immediately download the changes to the doors, select Hardware from the Doors menu,

right-click on the Access GW Driver, and select Apply Credential Changes. This activates the
changes on all doors. The badge is ready for use.
– To change the interval that credential changes are automatically downloaded to the doors, select

System Configuration from the Admin menu, and then select Cisco Settings. In the field
Credential download frequency (mins), enter the number of minutes between downloads. To
activate changes to the Cisco Settings, you must restart the Cisco PAM appliance. See Cisco
Settings, page 16-20 for more information.
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Figure 10-5

Step 9

Personnel Record: Badges General Window

Click the Logins tab to edit the logins and profiles assigned to the person. Multiple login usernames can
be associated with a personnel record.
a.

From the main window for the Personnel record, click the Logins tab.

b.

Click the Add... or Edit... button to open the Logins window, as shown in Figure 10-6.
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Figure 10-6

Step 10

Personnel Record: Logins Window

c.

Complete the General settings. For field descriptions, see Creating User Login Accounts and
Assigning Profiles, page 6-8.

d.

Complete the Profiles fields to define the access privileges for the login. For field descriptions, see
Creating User Login Accounts and Assigning Profiles, page 6-8.

e.

Click Save and Close.

Click the Custom tab to edit the custom-defined fields for the personnel record. This window includes
text and date fields to hold information specific to an organization (see Figure 10-7).
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Figure 10-7

Step 11

Personnel Record: Custom Window

Click Save and Close in the Personnel Record window to make the changes permanent.

Viewing Audit Records and Events for Personnel Records
This section describes how to view a list of audit records and events for personnel records.
Audit records are generated when a record is added, deleted, or modified, and display information about
the change. Events are records of actions, such as attempts to gain access to an access point.
This section includes the following information:
•

Viewing Audit Records, page 10-9

•

Viewing Recent Events, page 10-11

Viewing Audit Records
Step 1

Select Personnel from the User menu.

Step 2

Double-click an entry (or select the entry and click Edit).

Step 3

Select Audit Records, as shown in Figure 10-8.

Step 4

Double-click an entry to view details for the item. Table 10-4 describes the audit record fields.
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Figure 10-8

Personnel Audit Records Window

.

Table 10-4

Personnel Module: Audit Records Fields

Field

Description

Time

The time and date when the modification occurred.

Time Received

The time and date when the modification was saved.

Site

The site where the modification occurred. A site is a single instance of a
Cisco PAM database.

Type

The type of change.

Log code

An abbreviated code uniquely identifying the type of change.

Priority

A priority used for sorting events and alarms. Positive priorities are above
normal priority, while negative priorities are below normal priority. Zero is
normal.

Description

A description of the change.

Device

The workstation name where the modification occurred. Click View to display
details for the device where the change was made, including the IP address of
the workstation device.

Credential

The username used when the modification occurred. Click View to display and
revise details for the username.

Personnel record

The name of the operator associated with the modification (if the login was
associated with a personnel record at the time).

Data

Additional information about the modification.
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Table 10-4

Personnel Module: Audit Records Fields (continued)

Field

Description

View Current...

Opens a new window displaying the current settings.

View Before...

Opens a new window displaying the settings before the change was made.

View After...

Opens a new window displaying the settings after the change was made.

Viewing Recent Events
Step 1

Select Personnel from the User menu.

Step 2

Double-click an entry (or select the entry and click Edit).

Step 3

Select Recent Events.

Step 4

Double-click an entry to view details for the item. Table 10-5 describes the fields. Use the View, Report
and Filter buttons for increased functionality.
Table 10-5

Personnel Module: Recent Events Fields

Field

Description

Time

The time and date when the event occurred.

Description

A description of the event.

Device

The device associated with the event.

Address

The address of the device.

Personnel Record

The personnel record associated with the event.

Data

This field displays detailed information about the event, the exact value
and meaning of which depends on the type of event. This field is generally
for advanced or troubleshooting use. If the event is associated with an
attempt to gain access to an access point using a badge that is not in the
database, this field contains the card number.

Credential

If the event has an associated credential (such as a badge or login), the
identifying information of the credential (such as a card or username) is
displayed in this field.

Site

The site where the event occurred.

Editing Organization and Department Lists
Personnel records include an organization and department for the user (see the Occupational section of
Personnel configuration, as described in Configuring Personnel, page 10-2, Step 6).
To define the organization and department selections, do the following:
Step 1

Select Organization from the Users menu, as shown in Figure 10-9.
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Figure 10-9

Step 2

Step 3

Organizations: Main Window

Select one of the following options:
•

To add a personnel record, choose Add....

•

To modify an existing record, select the entry and click Edit. You can also double-click the entry.

•

To delete an entry, select the item and click Delete.

If adding or editing an item, the General window appears, as shown in Figure 10-10.
Figure 10-10

Organizations: General Settings

Step 4

Enter the name of the organization an optional comments to describe the entry.

Step 5

Click the Department tab to edit the list of departments for the organization (Figure 10-11).

Step 6

Click Add to create a new department entry. To edit an entry, select the item and click Edit, or
double-click the entry. To delete an item, select the item and click Delete.
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Figure 10-11

Organizations: Departments Window

Step 7

Click Save and Close to return to the main window.

Step 8

Click Save and Close again to save the organization and department changes and close the main window.

Importing Personnel Records Using a Comma Separated Value
(CSV) File
Large amounts of personnel records can be added to Cisco Physical Access Manager using a Comma
Separated Value (CSV) file. A CSV file can be extracted from all common database vendors. This is the
recommended method for the initial transfer of records into Cisco PAM.

Before You Begin
Review the following notes before creating EDI projects:
•

To avoid system delays, do not import more than 5,000 personnel records at a time. If necessary,
create multiple import files of less than 5,000 records each, and then import each file.

•

Personnel records are unique based on the ID number of the record. If a record is imported with the
same ID number, then the current record is overwritten with the new data.

•

When organization and department values are included in an imported personnel record, those
values must already exist in the Cisco PAM configuration. Add the Organization values by manually
creating them or through a data import. See Editing Organization and Department Lists, page 10-11
for more information.

Once a personnel CSV file is extracted from a database it can be added to Cisco PAM using the following
process:
Step 1

Enable the CSV personnel import wizard.
a.

Select System Configuration in the Admin menu.

b.

Select the Data Entry/Validation - Personnel tab (Figure 10-12).
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Figure 10-12

Data Entry/Validation -Personnel

c.

Select the check box for Use CVS personnel import wizard.

d.

Click Save.

e.

Restart the Cisco PAM application to activate the changes (close all Cisco PAM windows and
re-launch the application). Changes are not in effect until Cisco PAM is restarted.

Step 2

Select Personnel from the User menu.

Step 3

Select CSV Import Wizard... from the Add... button drop-down menu (Figure 10-13).
Figure 10-13

Step 4

CSV Import Wizard

In the File Selection window, select the file to import into Cisco PAM, as shown in Figure 10-14.
a.

Click the Browse... button and locate the CSV file.

b.

Select the checkbox for File has a header row if the CVS file includes data for a header row.

c.

Select a file for Rejected records output file.

d.

Click Next.
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Figure 10-14

Step 5

CSV File Selection

In the Column Configuration window (Figure 10-15), the top window contains entries from the CSV
file with generic column headings such as Column 1, Column 2, etc. The bottom left-hand window
displays the currently select column number in the CSV file and the name of the CSV field.
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Figure 10-15

Note

CSV Import Column Selection

The header row entry will be blank if the File has header row check box is not checked in the previous
step. The bottom right-hand of the window, labeled Import as: contains field names from the
Cisco PAM database.
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Assign a Cisco PAM field for each CSV field to be imported (Figure 10-15). Personnel records are
unique based on the ID number of the record. If a record is imported with the same ID number, then the
current record is overwritten with the new data.

Note

Step 6

a.

Select a CSV column in the top window. By default, Column 1 will be selected, as is shown by the
diamond symbol to the left of the column name.

a.

Select the Import as field in the lower right-hand window. This defines the Cisco PAM field that
corresponds with the selected CSV field.

b.

Assign all CSV columns to an Import as field.

c.

Click Next. The Next button is not enabled until all CSV fields are assigned.

Personnel photos in the .jpg format can be imported. The CSV field assigned to the Cisco PAM photo
field must contain the name of the photo file. In Windows, if a fully qualified path is not specified in the
CSV field (e.g. c:\photos\123456789.jpg) then the location of the photos will be assumed to be on the
desktop (e.g. C:\Documents and Settings\Desktop\123456789.jpg).
In the Preview window, verify the records and fields before importing, as shown in Figure 10-16.
Figure 10-16

CSV Preview
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•

New Records and Updated Records tabs: Select of deselect the checkbox to include or exclude the
personnel record from the import.
– Click View to display a preview of the imported personnel record that will be created.
– Click Back to revise the settings if necessary.

•

Invalid Records tab: displays personnel records that cannot be imported, including the reason for
the failure.
– Click Export to save the invalid records to a CSV file so they can be modified and re-imported.
– The export file is defined in the File Selection screen (see Step 4). Click Back to revise the

settings if necessary.
Step 7

Click Finish to complete the import and add the personnel records to the system.

Configuring Badges
Badges are assigned to personnel records. Use badge templates to define common settings for badge
types. In the personnel record, select the badge template to quickly populate the badge fields, and then
make additional changes, if necessary.
This section includes the following information.

Tip

•

Configuring Badge Templates, page 10-18

•

Badge Properties, page 10-20

•

Using the Badge Designer, page 10-25

•

Printing Badges, page 10-32

Use the Personnel module to assign badges. Use the Badges module to view a summary of all the badges
in the system. or to assign unassigned badges. Use the optional Badge Designer to create custom designs
for your badges.

Configuring Badge Templates
To do this
Step 1

Use this display

Select Badge Templates from the User menu.
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To do this
Step 2

Click Add, or select an existing template and click
Edit.

Step 3

a.

Enter the template name.

b.

Click Edit Template.

a.

Enter the badge properties. See Badge
Properties, page 10-20 for field descriptions.

b.

Click OK

Step 4

Step 5

Use this display

Click Save and Close. The template is listed in the
main window.
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Badge Properties
This section describes the badge menus and settings. These settings are available in the Personnel, Badge
Template, and Badges windows.
•

Use the Personnel module to create and assign badges.

•

Use Badge Templates to create pre-configured templates of common settings.

•

Use the Badges module to view a summary of all the badges in the system. or to assign unassigned
badges.

This section includes the following information:
•

Badges Module: General, page 10-20

•

Badges Module: Cisco Access Policy, page 10-22

•

Badges Module: Advanced Gateway, page 10-23

•

Badges Module: Audit Records, page 10-23

•

Badges Module: Recent Events, page 10-24

Badges Module: General
The General tab includes basic information about the badge.
Table 10-6

Badges Module: General Fields

Field

Description

Card #

(Required) Also known as a badge. A type of credential encoded with
a card number, generally on a magnetic stripe or internally like a
proximity card, and used to enter access points.
Tip

If unsure what the card # is on the card, use the card in the
access-control system reader. Open the Events module and
view the event with the description Access denied: Card not
in database. The Data field of the event displays the card
number read from the card. See Viewing Audit Records and
Events for Personnel Records, page 10-9.

PIN

(Required) Personal Identification Number. A badge has a PIN
associated with it, which, depending on the configuration of an
access point, is entered into the keypad on the access point's reader.

Hot stamp

(Optional) The number physically printed or embossed on a badge.
This number is generally independent of the Card Number. Not all
badges have a hot stamp number.

Facility code

(Optional) A segment of bits encoded on a card that represent a
number for a facility. Often all cards issued for a single facility have
the same facility code.

Exempt from Anti-passback

(Optional) If the access point is configured for anti-passback, the
badge is exempt from anti-passback enforcement.

Grant One Free APB Pass

(Optional) The badge holder will be anti-passback exempt during the
next reader use only.
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Table 10-6

Badges Module: General Fields (continued)

Field

Description

Badge Type

The type of badge. The options are:
•

Standard

•

Temporary

•

Visitor

Assigned to

(Optional) The personnel record the badge is assigned to.

Validity

(Optional) The current status of the badge. Only the Active option
provides access for the badge. The options include:

Effective

•

Active: Must be set to this value for access to be granted.

•

Inactive: Access is denied for all access points in system.

•

Lost: Access is denied for all access points in system.

•

Stolen: Access is denied for all access points in system.

•

Destroyed: Access is denied for all access points in system.

(Optional) The beginning date the badge can be used in the system.
If blank, badge access begins immediately.
Note

Expires

If a date is entered, the badge can be used at 12.00 AM on the
specified day.

(Optional) The date the badge expires. If blank, the badge never
expires.
Note

If a date is entered, the badge expires at 12.00 AM on the
specified day.

Site

(Optional) A site is a single instance of a Cisco PAM database.

Comments

(Optional) Any additional comments or notes about the badge.
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Badges Module: Cisco Access Policy
Select the door access policies for the user badge. See Configuring Access Policies, page 11-2.
Figure 10-17

Badges: Cisco Access Policy Selection
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Badges Module: Advanced Gateway
Advanced settings for the Cisco Physical Access Gateway.
Table 10-7

Badges Module: Advanced Gateway Fields

Field

Description

Credential template ID

The Credential Template for the badge. This allows the badge to
be recognized by the Cisco Physical Access Gateway as a valid
badge.
See Configuring Credential Templates, page 9-16 for more
information.

Temporary deactivation date

(Optional) The start date to temporarily deactivate a badge.
Click on the entry field to open a pop-up calendar, and then
double-click to select a date.
For example, to deactivate a badge for a one-week vacation
beginning January 1, select the date from the pop-up calendar,
and then enter 7 in the following duration field.
If a date is entered, the badge deactivation begins at 12.00 AM
on the specified day.

Temporary deactivation duration (Optional) The duration of the temporary deactivation, in days.
For example, to deactivate a badge for a 7 day vacation, enter 7.
Use limit

(Optional) The maximum number of times a badge can be used.
When the limit is reached, the badge is deactivated.

Role

(Optional) The role of the person who carries the badge:
Employee, Contractor, Vendor, or Temporary.

Executive credential

If checked, specifies that the badge belongs to an executive.

PIN exempt

If checked, the badge holder is not required to enter the PIN for
a reader in Card and PIN mode.

ADA access enable

If checked, the badge will use the ADA door strike time,
allowing the badge holder more time to pass.

Badges Module: Audit Records
When an operator adds, deletes, or modifies a record, an audit record is generated. The following
information is included in each audit record:
Table 10-8

Badges Module: Audit Records Fields

Field

Description

Time

The time and date when the modification occurred.

Time Received

The time and date when the modification was saved in the application.

Site

The site where the modification occurred.

Type

The type of change made.

Log code

An abbreviated code uniquely identifying the type of change.
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Table 10-8

Badges Module: Audit Records Fields (continued)

Field

Description

Priority

A priority used for sorting events and alarms. Positive priorities are above
normal priority, while negative priorities are below normal priority. Zero is
normal.

Description

A description of the modification: what type of record was modified, and
whether it was inserted, updated, or deleted.

Device

The name of the workstation device where the modification occurred.

Address

The address of the workstation device where the modification occurred.

Credential

The login that the operator was logged in with when the modification occurred.

Personnel record

The name of the operator associated with the modification, if the login was
associated with a personnel record at the time.

Data

Additional information about the modification.

View Current...

Opens a new window displaying the current settings.

View Before...

Opens a new window displaying the settings before the change was made.

View After...

Opens a new window displaying the settings after the change was made.

Badges Module: Recent Events
Lists the recent events of the selected badges. Use the View, Report and Filter buttons for increased
functionality. The following fields are listed in the recent events list:
Table 10-9

Badges Module: Recent Events Fields

Field

Description

Time

The time and date when the event occurred.

Description

A description of the event.

Device

The device associated with the event.

Address

The address of the device.

Personnel Record

The personnel record associated with the event.

Data

This field displays detailed information about the event, the exact value
and meaning of which depends on the type of event. This field is generally
for advanced or troubleshooting use. If the event is associated with an
attempt to gain access to an access point using a badge that is not in the
database, then this field contains the card number.

Credential

If the event has an associated credential (such as a badge or login), the
identifying information of the credential (such as a card or username) is
displayed in this field.

Site

The site where the event occurred.
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Using the Badge Designer
Use the Badge Designer to create and modify badge designs, as described in the following instructions.

Note

Step 1

This feature requires an optional Cisco license. The Badge Designer menu appears only after the license
is installed on the Cisco PAM server. See Obtaining and Installing Optional Feature Licenses, page 4-17
for more information.
Select Badge Designer from the Admin menu. The main window of the Badge Designer module
displays all badge templates loaded into the system.
Figure 10-18

Step 2

Badge Designer Main Window

Do one of the following:
•

View or modify an existing template:
– Click an existing template name to view details of the template. Click the Front and Back tabs

in the design window to view both sides of the badge template. Select the checkbox Preview
Sample Data to preview the badge template with sample data, if included in the template
design.
– Click Properties... to edit the name and size of the badge template. Skip to Step 4 for

instructions.
– Click Design... to edit the graphic design of the badge template. Skip to Step 6 for instructions.
– Click Duplicate... to create a duplicate of the badge template.
– Click Delete... to delete the badge template.
– Click Print... to print a test badge template.
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– Click Add...: to add a new badge template, as described in the following steps.
Step 3

To create a new template, click Add... to open the SVG Badge Format window, as shown in
Figure 10-19.
Figure 10-19

Step 4

New Badge Format

Enter the template properties:
a.

Name: Enter a descriptive name.

b.

Format: Select if the badge is single sided or double sided.

c.

Orientation: portrait or landscape.

d.

Card Size: Select a standard size, or enter custom dimensions. Standard size options include:
– CR-80 Flush Cut 54 x 85.7mm
– CR-80 Lip Seal 48 x 80mm
– Badge 67 x 98mm
– Badge 79 x 99mm
– IBM 59 x 82.5mm

Tip

To modify an existing template, select the template name from the main window and click Design button.
To edit the properties for an existing template, click the Properties button.

Step 5

Click OK. The Badge Format Editor opens in the format, orientation, and size configured in Step 4.
For two-sided badges, there is a separate window for the front and back of the templates, as shown in
Figure 10-20.
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Figure 10-20

Step 6

Tip

Badge Format Editor

Use the Tool Bar icons at the top of the window to design the template. The icons include the following
tools (from left to right):

Hold the mouse cursor over an icon to view the icon title.
•

Color: Click the icon to select a color and then drag and drop the color on a shape to apply that color.

•

Mouse Pointer Tool: Select and move objects on the badge template.

•

Rectangle Tool: Draw rectangle objects.

•

Circle Tool: Draw a circle.

•

Ellipse Tool: Draw an ellipse.

•

Line Tool: Draw a line.

•

Polygon Tool: Draw a polygon.

•

Polyline Tool: Draw an a polygon with operator defined line lengths.

•

Text: Add text to the template.

•

Image: Add an image to the template.

•

Quadratic Bezier Curve: Create a line between 3 points.

Cisco Physical Access Manager User Guide
OL-19461-02

10-27

Chapter 10

Configuring Personnel and Badges

Configuring Badges

Step 7

•

Cubic Bezier Curve: Create a line between 4 points.

•

Color Picker Tool: Select a color from the palette.

•

Image Link: Create an image link to the Cisco PAM database. Options include: personnel photos
or signatures.

•

Text Link: Create a text link to the Cisco PAM database. Options include: Personnel and Badge
Manager fields.

•

Properties: Properties available for the selected object.

•

Resources: Resources of the selected object.

Draw a rectangle, as shown in Figure 10-21.
Figure 10-21

Step 8

Step 9

Badge Format Editor: Rectangle Tool

a.

Click the rectangle button in the tool bar and drag a rectangle on the badge template.

b.

To edit the colors of the rectangle, click the Color button on the left side of the Tool Bar.

Select a stroke color for the badge. The stroke is the outline of the rectangle.
c.

Select the rectangle on the badge template to display blue arrows at each corner.

d.

In the Properties section select the Stroke tab.

e.

With the Color radio button selected use the Color picker and choose a desired stroke color.

f.

Select an appropriate width value. The Width field increases the size of the stroke.

g.

Press Enter or click outside of the field to apply the setting.

Select a fill color for the badge. The fill is the color of the rectangle.
a.

Click the Normal button (displayed as an arrow) in the Tool Bar.
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Step 10

b.

Select the rectangle on the badge template. The rectangle is displayed with blue arrows at each
corner.

c.

In the Properties section select the Fill tab.

d.

With the Color radio button selected use the Color picker and choose a desired fill color.

e.

Press Enter or click outside of the field to apply the setting.

Add a logo to the badge template:
a.

Click the Image button.

b.

On the template, click and drag a rectangle at a desired location for the logo to open the image
browser.

c.

Select a valid file type (.jpg,.png, and.svg) on a local drive and click Open. The logo appears in the
box, as shown in Figure 10-22.

d.

Click and drag the logo to a desired location.

Figure 10-22

Step 11

Badge Format Editor: Logo

To add a dynamic text field to the badge template:
a.

Click the Text Link button in the Tool Bar.

b.

In the Properties section select the Database Text Link tab, as shown in Figure 10-23.

c.

In the field drop-down select the correct text link. This text link extracts the field from the database.
For example the Title text link field extracts the personnel title from the database.

d.

(Optional) In the Properties section select the other attributes of the text, such as size and font.

e.

Click and drag the text to a desired location.
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Figure 10-23

Step 12

Tip

Badge Format Editor: Database Text Link

To add a dynamic image to the badge template:
a.

Click the Image Link button in the Tool Bar.

b.

Click and drag a rectangle on the badge temptingly where the image will appear.

c.

In the Properties section select the Database Image Link tab.

d.

In the field drop-down select Photo, as shown in Figure 10-24. This object extracts the photo from
the personnel database.

e.

Click and drag the box to a desired location.

Select Select Optimize Images from the File menu to resize all photos to the area they occupy on the
badge. If the photos do not optimize with sufficient resolution, you may need to manually resize photos
in an external photo editor to achieve the best possible print quality. See Printing High Resolution
Images, page 10-33 for more information.
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Figure 10-24

Badge Format Editor: Database Image Link

Step 13

Click the File button and select Save All to save changes.

Step 14

Click the File button and select Exit to close the Badge Format Editor. The new template appears in
the Badge Designer, as shown in Figure 10-24.
Figure 10-25

Badge Designer With New Template
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Printing Badges
To print personnel badges, do the following:
Step 1

Purchase and install the Badge Designer license to enable badge printing. See Obtaining and Installing
Optional Feature Licenses, page 4-17 for instructions.

Step 2

Create the badge designs, as described in Using the Badge Designer, page 10-25. You can also use one
of the four designs included with Cisco PAM.

Step 3

Print the badge:
a.

Select Badges from the User menu.

b.

Select a badge and click Edit.

c.

Click the Badge Printing tab and select a Format, as shown in Figure 10-29. Formats are the
designs created using the Badge designer.

Note
d.
Step 4

Badge Printing appears only after the Badge Designer license is installed.
Click Print.

Configure a default printer. These steps only occur the first time you print a badge.
a.

Click Yes to configure the default printer. This defines the printer used to print Cisco PAM badges.

b.

In the Select print configuration window, select Create new configuration.

c.

In the Print window, select a printer, and click OK.

d.

In the Page Setup window, adjust the settings if necessary, and click OK.

e.

Enter a name for the printer configuration and click OK. For example: USB Printer.

f.

Wait for the badge to print on the selected printer.
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Figure 10-26

Badge Printing

Printing High Resolution Images
The highest possible photo print quality is achieved when the resolution of the photo matches the print
resolution of the printer: the target width and height of the photo should be multiplied by the printer
resolution.
For example, if you are using a 300 dpi (dots-per-inch) printer, the ideal photo resolution that will occupy
a 1" x 1" ares is 300 x 300 pixels, a 2" x 2" area is 600 x 600 pixels, and a 2" x 3" area is 600 x 900 pixels.
Mathematically, the ideal resolution can be calculated as (rX, rY) = (w*DPI, h*DPI) where:
•

(rX, rY) is the resolution of the photo

•

rX

is the number of pixels in width

•

rY

is the number of pixels in height

•

w

is the target width of the image on the badge

•

h

is the target height of the image on the badge

•

DPI

is the resolution (dots-per-inch) of the printer

The Badge Format Editor includes a function to automatically optimize images.

Note

1.

Select Badge Designer from the Admin menu.

2.

Click the Design button to open the Badge Format Editor.

3.

Select Optimize Images from the File menu to resize all photos in the template to the area they
occupy on the badge.

If the photos do not optimize with sufficient resolution, you may need to manually resize photos in an
external photo editor to achieve the best possible print quality.
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Adding or Removing Badge Printers
Step 1

Select Preferences from the Options menu.

Step 2

Click the Badge Printers tab.
Note

Badge Printers appears only after the Badge Designer license is installed.

Step 3

Click Add to select a new printer, or highlight an existing printer and select remove.

Step 4

Click OK.
Figure 10-27

Badge Printing Preferences

Configuring Printing Options
Step 1

Select System Configuration from the Admin menu.

Step 2

Select the Miscellaneous tab (Figure 10-30).
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Figure 10-28

Step 3

Badge Printing Options in the Miscellaneous Settings

Select or deselect one or more of the following options.
Field

Description

Use cross-platform page setup
dialog for badge printing

Select this option to use the cross-platform Java page dialog if the
badge image is truncated. This occurs when using the default
printer dialog on some printers (such as the Zebra printer).

Truncate imageable area values If the image is still truncated using the cross-platform Java page
used to initialize cross-platform dialog, select this option to apply .01 inch margins.
page dialog
Use Pageable print interface for The Java Printable printing interface is used by deafult. If printing
badge printing
problems occur (such as with the Evolis printer), select this option
to use the Java Pageable printer interface.
Stroke text before printing
badges

If problems occur printing text, such as on a Mac, select this
option to apply a stroke when printing.

Step 4

Click Save to save the changes.

Step 5

Restart Cisco PAM (exit and relaunch the application) to activate the changes.

Note

Changes to system configuration settings do not take effect until the Cisco PAM desktop application is
restarted (exit and re-launch the application).
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Setting Up Image and Signature Options for Personnel Records
To add images and signatures to personnel records, enable the features as described in this section:
•

Enabling Image Capture Devices

•

Enabling Signature Capture Devices

Enabling Image Capture Devices
Cisco PAM supports capture devices (badging cameras) that use TWAIN drivers. Before proceeding to
the steps below, install all necessary camera drivers including TWAIN drivers. If unsure if the camera
uses a TWAIN driver contact the camera manufacturer for assistance.
Step 1

Select Preferences from the Options menu.

Step 2

Select the Image Capture tab on the left of the Preferences window, as shown in Figure 10-29.
Figure 10-29

Preferences: Image Capture

Step 3

Check the Is present checkbox.

Step 4

Select the image capture device type from the Type: drop-down menu. The options are:
•

Video

•

TWAIN

Step 5

Click the Select TWAIN source from the list button to open a source window. All selected drivers
installed on the machine will be displayed. Select the correct driver and click the OK button.

Step 6

If necessary modify the image width, height and scale of the capture device using the following settings.
•

Final image width: The pixel width of the image capture.

•

Final image height: The pixel height of the image capture.

•

Preview image scale: The size of the image preview.

•

Crop height scale: It's recommended that the crop height and final image height are equal.
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Step 7

Click OK to save the settings.
The Capture button is activated in the Personnel module. See Configuring Personnel, page 10-2 for
more information. Click the Capture button and verify that the TWAIN driver is selected and opens
properly.

Enabling Signature Capture Devices
Step 1

Select System Configuration from the Admin menu.

Step 2

Select the Data Entry/Validation - Personnel tab at the left of the window, as shown in Figure 10-30.
Figure 10-30

System Configuration: Personnel Data Entry Window

Step 3

Check the Use signature capture box. Checking this box enables the signature capture capability in the
Personnel module.

Step 4

Click Save to save the changes.

Step 5

For system configuration changes to take effect, restart the Cisco PAM application.

Note

You must exit and re-launch the Cisco PAM application for the changes to take effect. The
Signature Capture menu in the Preferences window does not appear until the application is
restarted.

Step 6

Log in to the Cisco PAM application.

Step 7

Select Preferences from the Options menu.

Step 8

Select the Signature Capture tab on the left of the Preferences window, as shown in Figure 10-31
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Figure 10-31

Preferences: Image Capture

Step 9

Check the Is Present checkbox and the Type of signature pad from the drop-down. Select the
communications port from the drop-down.

Step 10

Click OK to save the settings. The signature detail in the Personnel module now includes an Import and
Capture button. See Configuring Personnel, page 10-2 for more information.
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